
HP Enterprise Discovery 
For the Windows® operating system 

Software Version: 2.52 

Release Notes 

Manufacturing Part Number: None 

Document Release Date: June 2008 

Software Release Date: June 2008  

  



Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notices 

© Copyright 1993-2008 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

Microsoft®, Windows®, Windows NT®, and Windows® XP are U.S. registered trademarks of Microsoft 
Corporation.  

Windows VistaTM is either a registered trademark or trademark of Microsoft Corporation in the United 
States and/or other countries. 

Java™ is a US trademark of Sun Microsystems, Inc. 

UNIX® is a registered trademark of The Open Group. 

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated. 

Pentium® is a registered trademark of Intel Corporation or its subsidiaries in the United States and other 
countries. 

For additional trademark information, see the “Copyright” chapter in the Reference Guide.  
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Support 

You can visit the HP Software Support web site at: 

www.hp.com/go/hpsoftwaresupport 

HP Software online support provides an efficient way to access interactive technical support tools. As a 
valued support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html
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HP Enterprise Discovery 

Release Notes 
Software version: 2.52 / June 2008 

This document provides an overview of the changes made to Enterprise Discovery for version 2.52. It 
contains important information not included in the manuals or in the online help. 

In This Version

New Features

Obsolete Features 

Documentation Updates

Installation Notes

Enhancements and Fixes

Known Problems, Limitations, and Workarounds
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In This Version 

Introduction 

These release notes are for Enterprise Discovery 2.52. This new version of Enterprise Discovery is the 
upgrade path for users of Enterprise Discovery 2.5x, 2.2x and 2.1.x.  

If you want to see what features have been introduced in previous versions of Enterprise Discovery 
(including versions 2.1.x, 2.2x, 2.50, and 2.51), you can read the Release Notes for those versions, available 
on your installation CD under bin\documentation.  

License Schema 

Each Enterprise Discovery server can collect data from a maximum of 50,000 inventoried devices and 60,000 
discovered devices in total. The port limit is 150,000 ports (whichever comes first). An Enterprise Discovery 
Aggregator can support 50 servers and up to 500,000 devices. 

The Automated Inventory license introduced in Enterprise Discovery 2.20 enables you to purchase inventory 
capability based on the number of devices that you expect to manage. This license replaces the Device 
Discovery and Device Inventory licenses provided in versions of Enterprise Discovery prior to 2.20. If you 
have purchased these two licenses for a previous version, you will have access to all features provided with 
the Automated Inventory license offered with version 2.52. 

Updated third party components 

• MySQL Enterprise 5.0.60-enterprise 

• JRE 1.5.0_15 
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New Features  
There are no new features in this release. This release contains bug fixes only. 
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Obsolete Features 
All features in 2.51 are supported in release 2.52. 
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Documentation Updates 
The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version. 

• Publish date, which changes each time the document is updated. 

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://h20230.www2.hp.com/selfsolve/manuals/ 

1 Uncheck Show only my products if checked. 

2 In the Product list, click the product name (for example, Enterprise Discovery). 

3 In the Version list, click the version number. 

4 In the OS list, click the operating system type. 

5 Click Search. A document list is displayed that matches your search criteria. 

6 In the document list, click the document title. The document opens in your browser window. 

 To view files in PDF format (*.pdf), Adobe® Acrobat® Reader must be installed on your 
system. To download the Adobe Acrobat Reader, go to the following URL: 

www.adobe.com

The following PDF documents are available in the Enterprise Discovery user interface: 

• Planning Guide  

• Installation and Initial Setup Guide 

• Configuration and Customization Guide 

• Network Data Analysis Guide 

• Scan Data Analysis Guide 

• Reference Guide 

The Reference Guide has been reissued for release 2.52 because of updated copyright information. 

One additional PDF file is available on the install CD at bin/documentation: 

• Legacy Scanners 

8 

http://www.adobe.com/


Installation Notes 
Installation requirements and instructions for installing Enterprise Discovery are documented in the 
Installation and Initial Setup Guide provided in Adobe Acrobat (.pdf) format.  

If you are upgrading from a previous version, you need to follow these steps: 

1 If you have created your own User SAIs, make sure you back them up manually before uninstalling 
Enterprise Discovery. Refer to the “Upgrading from Enterprise Discovery Version 2.1.x or 2.20” section 
in the “Upgrade and Migration Scenarios” chapter in the Installation and Initial Setup Guide for details. 

2 Save an external backup of your data, if necessary.  

3 Uninstall the old version of Enterprise Discovery, using the Windows “Add/Remove Programs” feature.  

Depending on the version you are upgrading from, delete one of the following directories from the server:  
 
Version 2.1.x: C:\Program Files\HP OpenView\Enterprise Discovery\2.1.* 

Version 2.2x: C:\Program Files\HP OpenView\Enterprise Discovery\2.2* 

Version 2.5x: C:\Program Files\Hewlett-Packard\Enterprise Discovery\2.5* 

4 Reboot the server before you install the new version.  

The uninstall will not delete the Enterprise Discovery Data directory. Rebooting the server will ensure 
that all parts of Enterprise Discovery are removed. 

5 Install the new version and follow the steps in the Installation and Initial Setup Guide. 

If you changed the default location of the Data directory when you installed a previous version, you need 
to ensure that you use the same location when you install the new version.  

  

 Perl, MySQL, Tomcat and Apache are standard parts of the Enterprise Discovery, included with 
each server installation. If you have these components installed already, make sure to remove 
them before installing Enterprise Discovery. You may NOT substitute any other technologies in 
place of the standard installation. 
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Software and Hardware Requirements 

The Enterprise Discovery server can be installed on Windows 2003 Server, Service Pack 1 or Service Pack 2.  

Enterprise Discovery must be installed on a local disk. It cannot be installed on network drives, SAN drives, 
or clustered devices. Enterprise Discovery has been tested in a RAID (redundant array of independent 
drives) level 0 and level 1 environment. As a result, it has been determined that it can be successfully 
installed in a RAID level 0 or level 1 environment. 

RAID level 0 uses a striped disk array strategy that does not provide fault tolerance. Data striping spreads 
out blocks of each file across multiple disk drives. In our test environment we use 2 drives. This 
configuration does not provide for redundancy. It improves performance but does not deliver fault tolerance. 
If one drive fails then all data in the array is lost. 

RAID level 1 uses a mirrored set strategy that provides fault tolerance from disk errors and single disk 
failure. It results in increased read performance with very small performance degradation when writing. The 
array continues to operate so long as at least one drive is functioning.  

Because it offers the best tradeoff of performance and reliability, level 1 is the recommended RAID platform 
for Enterprise Discovery. For large networks, level 0 can also be used if performance is more important than 
fault tolerance. RAID level 5 is not currently supported. 

The following table details a variety of scenarios that can help you estimate your server hardware 
requirements. The Disk value is for your data directory. You will require at least 6GB for the Enterprise 
Discovery installation. 

Table 1 – Suggested Hardware Requirements 

Discovered 
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Devices Ports A

gg
re

ga
ti

on
 

A
u

to
m

at
ed

 
In

ve
n

to
ry

 

T
op

ol
og

y 

Memory 
(GB) CPU* 

Disk 
(GB) 

6,000 5,000 36,000 
 

x  1.5 
1 CPU 
2.4 GHz 25 

6,000 5,000 36,000 
 

x x   3** 
1 CPU  
2.8 GHz 40 

  18,000 15,000 108,000 
 

x  
   2 

2 CPUs or cores 
3.0 GHz 70 

18,000 15,000 108,000 
 

x x 5 
2 CPUs or cores 
3.0 GHz 105 

60,000 50,000 150,000 
 

x  4 
2+ CPUs or cores 
3.6 GHz 200 

60,000 50,000 150,000 
 

x x 7 
2+ CPUs or cores 
3.6 GHz 260 

50,000 50,000 n/a x n/a n/a 2 
2 CPUs or cores 
3.0 GHz 10 

500,000 500,000 n/a x n/a n/a 3 2 CPUs or cores 50 
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Memory 
(GB) CPU* 

Disk 
(GB) 

3.6 GHz 

* CPU processor speeds are approximate guidelines. Newer CPUs may have lower frequencies but higher 
performance than those shown in the table. HP Enterprise Discovery consists of multiple processes, many of 
which are also multi-threaded. As a result, it benefits from Simultaneous Multi-Threading (SMT) 
technologies such as Intel® Hyper-Threading and Multi-core. 

** This is for 5 map sessions. If you want to use more than 5 map sessions, you will require more memory. 

 
These requirements are running one XML Enricher. If you plan to run two XML Enrichers, more 
CPUs and more memory may be required. 

 
Enterprise Discovery routinely performs many disk access operations. In order to improve 
performance, especially for networks with a large number of devices, it is recommended that you 
use fast access disks such as SCSI. 
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These calculations have been tested as scenarios for maximum disk size on the server.  

For the Inventory license, this includes: 

• Backup Scan Files is enabled (on average, each scan file is 250KB) 

• Generate MIF Files is enabled  

• Delta scanning is enabled 

• Space required for two backups (one stored backup, and one “in process” backup) 

For the Network Topology license, this includes: 

• Statistic Export is enabled (CSV files) 

• 200 users, with each user account saving 10 map configurations files 

• Space required for two backups (one stored backup, and one “in process” backup) 

The Enterprise Discovery client has the following requirements: 

Operating System Windows 2000, XP, 2003 or Vista 

CPU Pentium® III, 500 MHz 

RAM 500 MB (1-3 GB if you will be analyzing a large number of scan files.) 

Disk 100MB required (2GB recommended) 

Java™ Runtime 
Environment 

5.0 or 6.0 
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Enhancements and Fixes 
The following items (identified by error tracking number) were added or fixed in this current software 
release. This release contains fixes only. 

Table 2 - Problems Fixed 

Number Location Fix Description 

QC 23 Server Unknown devices are no longer included in application license 
counts. 

QC 58 Linux Scanner The scanner no longer crashes under certain conditions when 
detecting the Logon ID hardware field. 

QC 88, 4438 Reports The information on Solaris zones in the Network 
Documentation and Virtual Device reports is now reported 
correctly. 

QC 106 Notification Event Filter notification delays configured in filter are now 
always taken into account. 

QC 193 Solaris Scanner Solaris scanners now collect the CPU/Core information 
correctly. 

QC 542 Scanner Generator Reading settings from a scanner configuration file generated 
by Enterprise Discovery 2.52 does not generate a warning 
that the file was generated by a different version of 
Enterprise Discovery. 

QC 1286 Discovery Engine Enterprise Discovery running without configured IP ranges 
no longer generates the "NMC is not in the seed list" error in 
discovery logs. 

QC 1338 HP-UX (ia64) 
Scanner 

In all cases, the CPU speed of Itanium 2 processors is now 
detected properly. 

QC 1366 Mac OS X Scanner Mac OS X (x86) scanner now collects detailed CPU cache 
information and correctly detects the logical CPU count for 
dual Core CPUs. 

QC 1391 Windows Viewer The last used date is now properly shown for all applications. 

QC 1485 Device Manager The scanner log file when viewed from the Device Manager is 
no longer truncated when it contains certain characters. 

QC 1583 AIX Scanner The AIX scanner collects the correct version of applications 
that have patches applied to them. 

QC 1638 Reports Devices in the End Node Top Listeners and Talkers reports 
are now sorted by the average traffic rates. 

QC 2337 Mac OS X (x86) 
Scanner 

CPU speed on Mac OS X (x86) machines is no longer 
erroneously detected as 0. 
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Number Location Fix Description 

QC 4431 Administration The dates appearing in the emails generated by Enterprise 
Discovery event notification are now RFC822 compliant. 

QC 4466 Windows Scanner Windows 2008 versioning is now detected and displayed 
accurately in the Enterprise Discovery Viewer. 

QC 4486 Windows Scanner Windows Vista Service Pack 1 is now detected properly on x64 
versions of Windows Vista. 

QC 4491 Aggregator Aggregation data can now be correctly imported from servers 
running versions of Enterprise Discovery that are older than 
the version running on the Aggregator server. 

QC 18757 Windows Scanner The Windows Scanner no longer hangs while detecting the 
CPU speed when running inside some VMware virtual 
machines. 

QC 18773 Windows Scanner The scanner no longer exits during printer detection. 

QC 18790 Reports "Utilization Details" reports are now sorted by the peak 
values. 
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Known Problems, Limitations, and Workarounds 

Agents 

• When you install the agent on Windows Vista machines not using the "Administrator" account, the 
firewall exception is not added into the exceptions list (QC# 382).  

• On Mac OS X 10.4.10 or above (Intel), there may be a problem with contacting the agent because it can 
be blocked by a firewall. The agent port needs to be enabled manually either via System Preferences > 
Sharing > Firewall or via the XServe administration tool in case of centralized administration (QC# 
674). 

Scanners 

• The scanner does not take into account the Files to Scan > Attributes option configured through the 
Scanner Generator (QC# 642). 

• Automounts are being scanned in HP-UX and Linux systems (QC# 1163).  

• The Mac OS X scanner does not collect information on cards and USB data (QC# 4481). 

Analysis Workbench 

• In File > Load Options > Asset Fields > Add > Text File Extract > Options, whenever the "Treat field as 
a File Name" option is selected, the "Replace invalid characters with" field must be populated as well, 
even if the "Delete invalid characters" option is selected instead.  Otherwise, the “The file ‘Replace 
invalid characters with’ may not be empty” error dialog appears (QC# 1275). 

• For files in the root directory, the leading slash is missing from the beginning of the UNIX directory 
structure in AW (QC# 1480).  

Server Installation 

• After an uninstall, the branding registry keys are left over (QC# 1434).  

• Non-ASCII characters used in data directory path name can cause problems during the installation 
(QC# 16520 and QC# 1472). 

• When uninstalling Enterprise Discovery on a small server, the uninstaller may not be able to stop the 
database. It may take several tries to uninstall the software (QC# 2405). 

• Enterprise Discovery with a Network Topology license should not be installed on VMware (QC# 5271). 

Server 

• An older OpenSSL DLLs in the system PATH can affect the Enterprise Discovery Apache server and 
Perl engines (QC# 5447). 

• If your server has another service using port 80, the HP Discovery Apache service will not run properly. 
As a workaround, you can comment out the "Listen 80" directive in the httpdf.conf file (QC# 6670). 

• If there is a MySQL query that takes too long, Enterprise Discovery will not function properly and you 
may need to restart System Monitor to recover (QC# 7409). 
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Web User Interface 

Administration 

• Depending on the licenses, the "Resource/ Environment manage" option in Discovery Configuration may 
not have any effect (QC# 7034). 

Reports 

• Sometimes web pages under Reports do not completely render or print source code in Mozilla Firefox. 
Use the refresh button (QC# 7558).  

Web Asset Questionnaire 

• In Internet Explorer, when connecting to the main page through a proxy server, the "You are connecting 
from" IP address reported will be the IP address of the proxy server not that of the remote computer 
address (QC# 764). 

• The UI may show non-printable characters in text fields (QC# 2408). 

Licensing 

Alarms License  

• Alarms-related items are not always hidden (QC# 5673). 

Internationalization 

• When non-ASCII characters are used to define Schedules in the Discovery Configuration, the Status > 
Current Settings > Discovery Configuration may display errors when listing the Configuration Profile 
information (QC# 490). 

• Various UI screens (reports, status reports, Device Manager, and so on) format the "day of the month" 
part of the date as Arabic numerals instead of using the language option configured by the operating 
system (QC# 416). 

• There are several problems with the SAI Editor accepting characters in the Korean code page (QC# 507, 
QC# 508). 

• The statistics graphs do not use the language options configured in the operation system and will always 
format the dates in English (QC# 2043). 
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